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Abstract 

In the current academic landscape, scientific research results are published through both 

traditional print and electronic formats, overseen by accredited institutions such as publishers 

and universities. This study explores the use of modern bibliographic data platforms, with a 

focus on Mendeley, to enhance the preparation and publication of scientific research in 

accordance with international standards. A comprehensive analysis was conducted involving 

84 participants—including master's students, PhD candidates, and researchers from Karshi 

State University—to assess their awareness and application of bibliographic tools and 

methodologies. Findings reveal that while 73% of respondents recognize the IMRAD structure 

as beneficial for scientific writing, 27% lack familiarity with international formatting standards. 

Furthermore, a significant number of participants were either unaware of or lacked proficiency 

in using virtual libraries like Mendeley, Google Scholar, and ResearchGate. Only 18% used 

these tools effectively, while 54% had only partial knowledge or usage experience. The 

research also identifies a practical gap in integrating citation tools within commonly used 

software like Microsoft Word. Based on these insights, the study highlights the need for 

targeted training programs and workshops on research methodologies and bibliographic tools 

in higher education. Encouraging educators and researchers to utilize platforms such as Scopus, 

Science Direct, and Mendeley can enhance scholarly productivity and visibility. Ultimately, 

the adoption of modern bibliographic systems plays a critical role in improving the quality and 

credibility of academic publications and advancing scientific communication. 
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Introduction 

Nowadays, the preparation and publication of scientific research results occur in two primary 

formats: traditional (in print) and electronic. The process of preparing and publishing articles 

and theses is overseen by organizations with special permissions (publishers, research 

institutes, and higher education institutions, etc.). In this article, we will briefly outline the 

research findings on utilizing modern bibliographic data platforms for preparing scientific 

research results for publication and the methodology of using Mendeley software (Visser et al., 

2021).  

A bibliography is a list of sources—such as books, articles, and websites—that a writer has 

used or referred to while researching and writing a document. Typically found at the end of 

academic papers, essays, books, or research reports, it provides essential information like the 

author’s name, the full title of the source, publication details (such as the publisher’s name, 

place of publication, and date), and, when relevant, page numbers or a URL/DOI for online 

sources. These key elements help ensure accuracy and consistency in citing materials. 
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The main purposes of a bibliography are to credit original authors, helping to avoid plagiarism, 

and to assist readers by guiding them to the sources for verification or further study. It also 

demonstrates the writer’s research efforts, showing that the work is grounded in credible and 

diverse sources. A well-prepared bibliography reflects academic integrity and supports the 

credibility of the overall work. 

Currently, the digitalization of activities in industrial sector (Chudaeva et al., 2019), 

management systems using information technologies (Alavi & Gallupe, 2003),  big data 

analytics and supply chain efficiency (Gunasekaran et al., 2017), information technologies in 

the healthcare system (Chaudhry et al., 2006), digital transformation  and entrepreneurship, the 

application of information technologies in the banking sector (Shanti et al., 2023), and the use 

of digital technologies in the education system are being studied, but good results are not being 

achieved (Timotheou et al., 2023).  

Main part. A scientific article is an independent outcome of scientific research, presenting the 

author's thoughts and reflections based on the study of scientific views and hypotheses known 

to the public to date on a relevant scientific problem (text, audio, video, etc.). For individuals 

pursuing high goals, the significance of a scientific article is paramount. In scientific articles, 

the researcher's personal contribution to the development of the theoretical or practical 

foundations of contemporary scientific fields is articulated as clearly as possible (Ahrens & 

Chapman, 2006). 

As a result of research on bibliography design and Visual Analytics online platforms, they have 

been proven to be the most effective tools (Heer & Shneiderman, 2012). However, when 

preparing some scientific works for publication, researchers cannot fulfill international 

requirements in creating a bibliography (Pranckutė, 2021). Analyzes and recommendations are 

given on the use of the system in research to improve the quality of scientific work of students 

(Kaklauskas et al., 2013) to search for research links in their journals and to organize training 

on access to the Mendeley desktop. 

In the initial part of the article, a brief and concise annotation (summary of the article) in 

international languages, along with keywords, should be included (Ovsiannikov et al., 1999). 

A scientific article is typically divided into several sections for information. The introductionof 

the article describes and justifies the relevance of the topic under discussion, as well as presents 

the field, object, and subject of the research, the purpose of the research, the tasks, the 

resolution of the posed problem, and the theoretical and practical significance of the proposed 

solution. 

Nowadays, international conferences and journals typically accept articles, theses, and 

monographs that adhere to the IMRAD (Introduction, Methodology, Results, And Discussion) 

format (Piran & Tran, 2024). This article aims to develop practical skills related to the modern 

bibliographic data platform Mendeley and its methodology for compiling the list of references 

cited in all articles and theses (Kusumaningsih et al., 2024). Mendeley (Elsevier) is a platform 

for managing bibliographic data that facilitates the creation of a social network for researchers 

based on its database (articles, theses, monographs, etc.), allowing users to store, organize, and 

annotate research data, easily generate citations, and swiftly change citation styles.  

To enhance scientific and innovative activities, it is essential for professors and educators to 

prepare and publish scientific articles in journals indexed in international scientific and 

technical databases such as Scopus, Science Direct, and Web of Science (Wardat & AlAli, 

2025). This will foster their publication activity as researchers and enrich their personal and 
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professional information space utilizing the capabilities of Scopus, Science Direct, and 

Mendeley systems. 

Before studying the main functions of Mendeley and its usage methodology, users need to 

understand international bibliographic standards. Below, we list the common types of 

bibliographic standards. MLA (Modern Language Association) is primarily used for creating 

bibliographic lists in the fields of language, literature, art, and other humanities.  NLM 

(National Library of Medicine) is a bibliographic style often developed by the International 

Committee of Medical Journal Editors (ICMJE) and is mainly used for compiling 

bibliographies in the publication of scientific research results in the medical field.   

ACS (American Chemical Society) is primarily used for citations in chemistry articles and has 

three variants of the style, depending on the choice of the scientific journal's editorial board. 

The American Chemical Society developed the ACS style for academic writing in chemistry, 

utilizing both numbered and author-date citation systems. APSA (American Political Science 

Association) is mainly used in research related to political science.   

IEEE (Institute of Electrical and Electronics Engineers) is a professional organization that 

supports many fields of engineering, computer science, and information technology. In 

addition to publishing journals and conference materials, IEEE establishes several standards 

for various fields. The IEEE citation style includes in-text citations indicated in square brackets 

that refer to the full citation listed at the end of the paper, with the bibliography organized by 

numbers rather than alphabetically. 

Methods 

This article is founded on a survey concerning the utilization of bibliographic data platforms 

by scholars and master's students involved in scientific research (refer to Table 1).   

Table 1. Research Findings on the use of Bibliographic Data Platforms for Preparing 

Scientific Activity Outcomes for Publication in Accordance with International Standards. 

№ Questions Answers 

1 Your age 23-28 29-38 39-53 54-65 

2 
Your professional – 

academic activity 

Master's 

student 

Doctoral 

student 

Independent 

researcher 

Scholar (PhD, 

DSc) 

3 

Are you familiar with 

the IMRAD format 

for writing articles? 

No 

 

 

 

 

Yes, I have 

some 

understanding 

I know it is an 

international 

requirement 

Of course, I 

know; all my 

work adheres 

to the IMRAD 

format. 

4 

Do you know about 

the virtual library of 

the past (Mendeley, 

Google Scholar, 

ResearchGate)? 

No, I 

don’t 

know 

Yes, I have 

heard of it, but I 

don’t know how 

to use it 

I know about 

it and use it to 

some extent 

Of course, I 

know and use 

all of them. 

5 

How do you compile 

your bibliography 

when writing article? 

I write 

it down 

one by 

one 

I use popular 

scientific 

platforms 

I just copy and 

paste. 

I use a 

bibliographic 

data platform 

https://doi.org/10.47667/ijppr.v6i2.368


International Journal Papier  Volume 5, Issue 4 (Page 060-069) 

Public Review  ISSN: 2709-023X 

 

 

63 
Copyright © 2025, International Journal Papier Public Review, Under the license CC BY-SA 4.0 

DOI: https://doi.org/10.47667/ijppr.v6i2.368   

 

6 

Are you familiar with 

international 

bibliographic 

standards (GOST, 

APA, MLA, etc.)? 

No, I 

want to 

learn 

about 

them. 

Yes, I have 

heard of them 

I have some 

information 

Of course, I 

know them. 

7 

Do you know about 

the Mendeley 

bibliographic data 

platform? 

No, I 

want to 

learn 

about it. 

Yes, I have 

heard of it 

I have heard 

of it, but I 

don’t know 

how to use it 

Of course, I 

know and use 

it. 

8 

Do you know how to 

automatically 

generate 

bibliographies in 

Mendeley? 

No, I 

want to 

learn 

about it. 

Is there such a 

program? 

I have heard 

of it, but I 

don’t know 

how to use it 

Of course, I 

know and use 

it. 

Most of the respondents participating in the research were professionals engaged in scientific 

activities, thus we left the section clarifying the individual open. This study was organized in 

collaboration with master's students, doctoral candidates, and researchers involved in scientific 

research at Karshi State University, and the survey was conducted online. A total of 84 

respondents participated in the study, and we will now analyze the information regarding their 

professional and scientific activities (Figure 1). As shown in the following diagram, 33 of the 

respondents (39.3%) were pedagogical master's students. Additionally, 25 respondents (29.8%) 

were included in the survey due to our researchers' interest in the topic. From the analysis of 

the survey regarding the use of bibliographic data platforms for preparing research results for 

publication according to international standards, we can understand that this topic is relevant 

and holds significant importance in conducting scientific research today. 

 

Figure 1. Information About the Professional and Scientific Activities of the Respondents 

In analyzing the age data of respondents, we observe that individuals aged 29-38 engaged in 

scientific research activities make up the majority (see Figure 2). Statistical analyses reveal that 

the average age of respondents is 38.5 years. This implies that for those involved in scientific 

research, half of their lifetime is dedicated to this field. To reach this conclusion, we utilized 

Master's student 
39%

Doctoral student 
12%

Independent 
researcher 

19%

Scholar (PhD, 
DSc)
30%
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statistical data on the average life expectancy of the population of Uzbekistan, published by 

international organizations that study global life expectancy. 

 

Figure 2. Analysis of Data by Age 

Organizations that publish international scientific research typically accept articles structured 

according to the IMRAD format. In our survey, we collected responses to the question, "Are 

you aware of the IMRAD format in article writing?" (Figure 3). 

 

Figure 3. About the IMRAD template 

During the research, the statistical data collected indicated that 73% of respondents viewed the 

IMRAD format in article writing as a positive outcome from a logical perspective. However, 

27% of respondents (22 individuals) seemed to lack knowledge of international standards for 

formalizing scientific research papers, with the majority of them (16 out of 22, or 73%) engaged 

in pedagogical activities. The average age of these respondents was found to be 25 years, 

25

27

25

7

0 5 10 15 20 25 30

54-65 39-53 29-38 23-28

No 
27%

Yes, I have 
some 

understanding 
26%

I know it is an 
international 
requirement 

29%

Of course, I know; all my 
work adheres to the 

IMRAD format.
18%
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highlighting the necessity of incorporating brief courses on research methodology for students 

in higher education institutions and conducting classes in a practical workshop format. 

The subsequent survey in the research concentrated on scholars' virtual libraries (Mendeley, 

Google Scholar, ResearchGate), clarifying respondents' research outcomes and their 

proficiency in utilizing social networks related to academic fields. The analysis revealed that 

24 respondents (28.6%) had heard of virtual libraries but lacked the skills to use them, while 

21 respondents (25%) confirmed they had no information about them at all. Among those who 

participated in the survey, 24 individuals (28.6%) stated that they partially used virtual libraries 

for publishing their research, and 15 (18%) responded positively to the survey question. The 

analysis of the four questions posed in the surveys indicated that 54% of respondents did not 

possess the skills to utilize virtual libraries. 

The results of the survey on the use of bibliographic data platforms for writing articles are 

illustrated in the following diagram (Figure 4). In this instance, 54% of respondents reported 

having partial knowledge about the survey concerning the use of bibliographic data platforms 

and are unsure how to utilize them, while 46% indicated that they partially employ modern 

software tools to create bibliographies in their scientific articles. The findings reveal that the 

current utilization of bibliographic data platforms in publishing scientific research results is 

inadequate, and addressing this issue falls primarily on higher education institutions and 

research institutes. 

 

Figure 4. Usage Of Bibliographic Information Platform 

The respondents answered the questions titled "How do you compile your bibliography when 

writing an article?" and "Are you familiar with international bibliographic standards (GOST, 

APA, MLA, etc.)?" as follows. From the responses to these questions, we can ascertain the 

opinions of 36 respondents (42.9% - "I want to learn about them") regarding the application of 

international standards in bibliography compilation. This describes the current low 

competencies in shaping bibliographies.  

 

21,0
24,0 24,0

15,0

No, I don’t know 
Yes, I have heard of it, but I don’t know how to use it 
I know about it and use it to some extent
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Figure 5. Usage International Bibliographic 

An analysis of respondents' answers to questions 7 and 8 of the survey is presented(Figure 6) 

in the chart below, with 40 respondents (47%) reporting Mendeley training. This question does 

not provide complete information about the process of automatically creating a Mendeley 

bibliography, but the concept of automatically creating a literature review is given in the 

previous questions. 

 

Figure 6. Usage Mendeley Bibliographic 

25,0

20,0

24,0

15,0

0,0 10,0 20,0 30,0

I write it down one
by one

I use popular
scientific platforms

I just copy and
paste.

I use a
bibliographic data

platform

36,0

16,0

18,0

14,0

0,0 10,0 20,0 30,0 40,0

No, I want to learn about
them.

Yes, I have heard of them

I have some information

Of course, I know them.

34,0

18,0

24,0

8,0

0,0 10,0 20,0 30,0 40,0

No, I want to learn
about it.

Yes, I have heard
of it

I have heard of it, 
but I don’t know 

how to use it 

Of course, I know
and use it.

40,0

17,0
18,0

9,0

No, I want to
learn about it.

Is there such a
program?

I have heard of 
it, but I don’t 
know how to 

use it 

Of course, I
know and use

it.
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Procedure for Installing the Mendeley Application 

To begin, download the application via this link 

(https://www.mendeley.com/?interaction_required=true) and execute the file.  To fully activate 

the application, registration on the Elsevier platform is required, as these systems operate in an 

integrated manner.  After launching the Mendeley application and activating the platform with 

a registered account, close the Microsoft Office applications and proceed to activate the 

installation of the MS Word plugin from Mendeley’s “Tools”→“Install MS Word plugin” 

menu. 

After launching the Word program, check if Mendeley is working from the "References" menu. 

In this case, it is verified that a separate task panel for Mendeley is allocated in the "References" 

menu and is active, confirming that the programs are integrated with each other. There are two 

methods available for importing articles: through the website and by uploading a PDF format 

article file to the program. 

 

Figure 7. Menu for Creating a Bibliography in Word Software 

In Word software, to insert a citation for the article being prepared, click the “Insert Citation” 

button in the “References” menu (Figure 7) and activate the “Go To Mendeley” button in the 

window that appears.  Once the Mendeley program is downloaded, you will be prompted to 

select and mark the necessary literature. After selecting the literature, the “Cite” command 

from the program's menu will be activated, and the bibliography will be created by clicking the 

“Insert Bibliography” button in Word. 

Conclusion 

This research studied and analyzed the skills of respondents engaged in scientific activities 

related to preparing research results for publication. The findings examined the use of 

bibliographic data platforms, and practical guidelines were provided for forming articles based 

on international standards. Promoting the use of modern software for preparing scientific 

research results for publication and reinforcing the requirements for authors to utilize 

bibliographic data platforms in publishing houses ensures the popularization of the work of our 

country's scholars. 

Recommendations 

We will examine the possibilities for the development of a comprehensive bibliography, we 

will analyze the main conceptual framework of bibliography[24], and we will develop a 

comprehensive bibliography. It is necessary to implement the development of a program that 

will enable us to develop the necessary public works that will enable us to work in the field of 

health and safety. 
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